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Overview

~ Counter Tops » The development of a reflected ceiling plan, the location and selection of lighting,

=Load . . . .
*Duplicate | the location of mechanical components (air supply and air return) needs to be

A developed in tandem with the layout of fixed and movable furniture in a given room.

* If aroom has multiple uses and multiple layout then the needs of these must be
balanced in the design of the reflected ceiling plan.

 To start begin by developing a room layout in plan. With this plan as an underlay
develop an appropriate lighting scheme that serves the functions of the room or
activity you are designing for.

» Next consider the mechanical requirements of the room and its activities.

« Consider options for the materials of the ceiling and the appropriate ceiling heights.

» Consider the location of structural , mechanical or other elements including
sprinkler systems, exit signs, etc.

» Consider the wall types that will abut the ceiling and develop appropriate details
» Consider the ratings of wall types and the distribution of mechanical systems.
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Double Click
on 24" Depth

ype Parameters

Parameter Value .
S

Construction
Construction Type

Annctaticn Symbols
Cable Trays

rtain Panels
Curtain Systems
rtain Wall Mullicns




Prof. Paul C. King
Copyright © 2013

Day 18 Project 17

Overview /

Counter Tops
=L'oad
=Duplicate
=Position
*Align & Length

=Layout Options
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Building Tech Il

CityTech

Counter Tops can be dragged
into the plan view from the
Project Browser

Tap on the space bar to
rotate the counter top in
90 degree increments
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Medify| Link Link DWF  Decal
Revit CAD Markup

Select = Link

Cloud

& Load Family

Point Manage | Import Import
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Insert
Links CAD gbXML from File

Import

Images

Image Manage

[ Dj Search Autodesk Seek

Load |Load as

Find and download building pro
Family| Group

u | Load from Library | Autode

Project Browser -

Look in: l | | Base Cabinets —

€8 X B vos -

=
Name

|| Base Cabinet-2 Bin.rfa

Preview
Date modified Type

27172013 3:43 PM RFA File

E || Base Cabinet-4 Drawers.rfa

RFA File

|| Base Cabinet-Built In.rfa
|| Base Cabinet-Corner Unit-Angled.rfa

2/1/2013 3:43 PM RFA File
2/1/2013 2:49 PM RFA File

[ || Base Cabinet-Double Door 8 2 Drawer.rfa

dmosmenwe  RFAFile

|| Base Cabinet-Double Door Sink Unit.rfa

2/1/2013 2:43 PM RFA File

| _| Base Cabinet-Filler.rfa

RFA File

| _| Base Cabinet-Single Door & Drawer.rfa

RFA File

|| Base Cabinet-Single Doorrfa
| Vanity Cabinet-Double Door 8 4 Drawer.rfa
|| Vanity Cabinet-Double Door Sink Unit.rfa

__| Base Cabinet-Single Door w Sliding Drawers....  2/1/2013 3:49 PM

RFA File
2/1/2013 3:43 PM RFA File
2/1/2013 3:43 PM RFA File

2/1/2013 3:43 PM RFA File

| || Vanity Cabinet-Single Door & Drawer.rfa

RFA File

|| Vanity Cabinet-Single Door.rfa

27172013 3:43 PM RFA File

Look in: i | Wall Cabinets
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Name

|| Upper Cabinet-Corner Unit Tall L-Wall.rfa
|| Upper Cabinet-Corner Unit-Wall.rfa

| Upper Cabinet-Double Deor w Glass-Wall.fa  2/1/2013 3:49 PM

Preview
Date modified Type

27172013 3:43 PM RFA File
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RFA File

E | Upper Cabinet-Double Door-Wall.rfa

RFA File

| _| Upper Cabinet-Filler-Wall.rfa
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|| Upper Cabinet-Single Door w Glass-Wall.rfa
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| _| Upper Cabinet-Single Door-Wall.fa
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- Cable Trays
o
Base Cabinet-4 Drawers
- Base Cabinet-Double Door & 2 Drawer

- Base Cakinet-Filler
.. Base Cabinet-Filler
Base Cabinet-Single Door & Drawer
Counter Top

- Counter Top-Island

- Upper Cabinet-Double Docr-Wall
Upper Cabinet-Filler-Wall
Upper Cabinet-Single Door-Wall

- Vanity Cabinet-Single Door & Drawer

1 |
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=Du p.Ii.Cate i D'WF Decal Point Manage | Import Import Insert . Image Manage Load |Load as |Fjnd and download building pro
*Position Revit CAD Markup v Cloud  Links CAD gbXML from File Images Family| Group

=Align & Len@th

Link Import Autode
=Layout Opgtiens

Cabinet§ —_
*Base/& Wall ! @ Cable Trays
=Basg Cabinets a

sework
*Wall Cabinets - X

Base Cabinet-4 Drawers

|sland & Wall Benches Baze Cabinet-Double Door & 2 Drawer
=El|evation
=\/iew Depth

=Center Labs
=Classrooms

=Hung Ceilings “"
*Origin &/Location 45
sLights & Ag"
Supply/Return . N
s Base Cabinet-Filler

=Double Bay. ... Base Cabinet-Filler

i Base Cabinet-Single Door & Drawer
=VView Range

=Lgcation Counter Top
=Lights Counter Top-Island

: Upper Cabinet-Double Door-Wall
=Typical Plan

- Upper Cabinet-Filler-Wall
{ Upper Cabinet-Single Door-Wall
Wrap Up Vanity Cabinet-Single Door 8 Drawer

=Teaching Labs

1 |
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Add Cabinets:

Add a 48" Double Door Cabinet in the center back 1" from the counter edge
Add a 24" 4 Drawer Cabinet on either side of the 48" cabinet
Add 3@ 48" and 4@ 24" cabinets alternating

—y @ﬁj—_
Room

603

Ty -

Room

~

603

L

24"
e
487
-

24"
- -

Add a Filler Panel at either end of
the bench and then stretch them
until they hit the wall.

Filler Panels fill in the gaps
between standard size cabinets
and non-standard counter lengths

i &

T [
Rl Fillad Pares
ol brih saadw
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Island & Wall Bencheés
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=\/iew Depth

=Center Labs
=Classrooms - .
View > Elevation:
=Hung Ceilings
=Origin &/Location
sLights &
Supply/Return

=Double Bay.
*View Range

sLgcation
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Elevation View:

=Typical Plan
=Teaching Labs
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Building Tech IlI
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Add new elevation view.

View of the base cabinets

Select the key > Go To Elevation View

1135
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Counter Tops Insert > Load Family: Select the following Upper Cabinet Families
:Eﬂ?ﬁicme Upper Cabinet-Double Door Wall

*Position Upper Cabinet-Single Door w/ Glass-Wall

=Align & Len@th

Upper Cabinet-Filler

=Layout Ogtions

Cabinet§
=Base& Wall
=BasgiCabinets
“Wall'Cabinets

Island & Wall Bencheés
=El|evation

=View Depth Add Cabinets: Workin the Elevation View. Add the matching wall cabinets 5'-0" from the floor
RBeNter Labs Add a 48" Upper Cabinet-Double Door-Wall aligned with the middle cabinet
=Classrooms Add a 24" Upper Cabinet-Single Door Glass-Wall on each side of the 48" cabinet

=Hung Ceilfngs Locate 3@ 48" and 4@ 24" wall cabinets alternating
=Origin &/Location

sLights &
Supply/Return

=Double Bay.

=\View Range
=Lgcation
=Lights

=Typical Plan
=Teaching Labs

Wrap Up
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CityTech
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Flip Door Swing: view select the double arrow to switch the direction of door swing

he Double-Arrows to switch the hinge
side of the upper single door wall cabinets

Add Filler Panels:
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Counter Tops Island Bench:

=L'oad
=Duplicate
=Position
=Align & Length

=Layout Offiohs Completed Lab:
Cabinet§

"Base/& Wall

=BasgiCabinets

“Wall'Cabinets

|§land & Wall Benchés
=El|evation
=\/iew Depth

=Center Labs
=Classrooms

=Hung Ceilings
=Origin &/Location
sLights &

Supply/Return
=Double Bay.
=\View Range
=Location
=Lights

=Typical Plan
=Teaching Labs

Wrap Up

Building Tech Il
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Theisland bench is 5-0" x 12'-2" with the cabinets set back 3" from the edge.
Add a 36" Double Door and a 18" 4 drawer at either end. Add a 48" double door

cabinet in the middle of each long side. There will be a space between cabinets.

Layout of a typical double and single lab

L |_I_I
35" 13“
5 x12'-2" Island

603
24"

48"
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=Duplicate
=Position

“Align & Lenglth Island Elevation:
=Layout Ogtions

Cabinet§
=Base& Wall
=BasgiCabinets
=WallCabinets

|§land & Wall Benchés
sE|evation
=\/iew Depth

=Center Labs
=Classrooms

=Hung Ceilings
=Origin &/Location
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Supply/Return

=Double Bay. .
Island Elevation:

*View Range
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=Typical Plan
=Teaching Labs
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Showing the short end with a 36" double door and a 18" 4 drawer cabinets
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Overview 4 Default Elevation:  The long elevation of the Island is confused with the cabinets beyond in the view

Counter Tops
=L'oad
=Duplicate
=Position
=Align & Length

=Layout Ogtions

Cabinet§
=Base& Wall
=BasgiCabinets
“Wall'Cabinets

|§land & Wall Bentheés

sElevation
=\View Depth Adjust View Depth: Froma plan view select the elevation key and drag to adjust the view depth
sCenter Labs /A 1‘&

=Classrooms :
=Hung Ceilings
=Origin &/Location
sLights &
Supply/Return

=Double Bay.
=\View Range
=Location

=Lights

=Typical Plan
=Teaching Labs

¥
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Counter Tops
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=Position §
=Align & Len@th
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Cabinet§ . . .
Base & Wall Island Elevation: A cleaner elevation with the depth adjusted
=BasgiCabinets
*Wall'Cabinets

|§land & Wall Bentheés
sE|evation
=\/iew Depth

=Center Labs
=Classrooms

=Hung Ceilings
=Origin &/Location
sLights &
Supply/Return

=Double Bay.
vidiRandl Alternate Method: Asan alternate you can adjust the Elevation Far Clip Offset Properties
=Lgcation Propuiia
sLights
Blevatsan
B E
=Typical Plan i
=Teaching Labs = | Ef Edit Type
Far Clipging
Wrap Up Far Clip Offset
Scope Box
Building Tech IlI

CityTech
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Overview 4 Center Lab Bays: Islands are 22'-2" x 5. Benches at walls are the length of the room
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sLights &
Supply/Return

=Double Bay.
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End Classrooms:

Three (3) end classrooms with flexible seating arrangements

dhieads
[ 8248044

e i L2y
TR T e T~
e l'-'m.l', . e o T
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=Position
=Align & Len@th

=Layout Ogtions
Cabinet§

"Base/& Wall
=BasgiCabinets
*Wall'Cabinets

|§land & Wall Benchés
sE|evation

=\/iew Depth

=Center Labs
*Classrooms Hung Ceilings:  Hung Ceiling are include grids, Ilghts supply & return ducts sprinkler heads etc.

=H Ceili

-OlrJirg;ign ;IL|ggaStion HllllllllE ..ll I..-
Suly/Ret A ™ 1 .-l
HESHNSEREN HESE

=Double Bay. IIII
4 |

sLights
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" IIIII I
= B'= =

“jiﬁiiiii

Wrap Up
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=Lights

=Typical Plan
=Teaching Labs

Wrap Up

Building Tech Il
CityTech

Consider Grid Size (2 x 4, 2 x 2), Origin and Rotation
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Lights:

Lights work with the grid
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Overview 4 3dPerspective:  View of Double Lab looking toward exterior Window Wall
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Isometric View

Isometric view of Double Lab from buil

ding exterior




Prof. Paul C. King
Copyright © 2013

Day 18 Project 17

Overview

Counter Tops
=L'oad
=Duplicate
=Position
=Align & Length

Default Depth:

=Layout Opgtiens

Cabinet§
=Base& Wall
=Basg'Cabinets
“Wall'Cabinets

|§land & Wall Benchés
sElevation
=\/iew Depth

=Center Labs
=Classroomg

Adjust View Depth:

=*Hung Ceilings
=Origin &/Location
sLights &
Supply/Return

=Double'Bay.
=View Range
=Lgcation

=Lights

=Typical Plan
=Teaching Labs

Wrap Up
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The default view depth of 7'-6" does not allow u

5 to see the lab counters.

L1l __ L I __1
T T T T T~ T

Set the view offset to 3'-0" so the lab counters are visible.
When done set the offset back to the default of 7'-6"
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Counter Tops
=L'oad
=Duplicate
=Position
=Align & Len@th

Place Ceiling: Home > Ceiling > 2 x 4 ACT system

=Layout Opgtiens

caninefll Nk (7]

*BasgiCabinets 5 = = - = = S S :

«Wall Cabinets Modify| Wall Door Window Component olumn  Roof [Ceiling| Floor Curtain Curtain Mullion
' ' N - System Grid

|éland & Wall Benghgs Sefect

*Elevation

=\/iew Depth

=Center Labs
=Classroomsg

*Hung Ceilings Add 2' x 4'

*Origin &/Location Grid Ceiling
sLights &
Supply/Return

=Double'Bay.
=View Range
=Lgcation

sLights

=Typical Plan
=Teaching Labs

Wrap Up

Building Tech IlI
CityTech



Prof. Paul C. King
Copyright © 2013

Day 18 Project 17

Load Family:

Overview

Counter Tops
=L'oad
=Duplicate
=Position
=Align & Length

=Layout Ogtions

Cabinet§

"Base/& Wall
=BasgiCabinets
“Wall'Cabinets

|§land & Wall Bentheés Add nghts'
sElevation

=\/iew Depth

=Center Labs
=Classroomg

=*Hung Ceilings
=Origin &/Location
sLights &
Supply/Return

=Double'Bay.
=View Range
=L gcation

=Lights

=Typical Plan
=Teaching Labs

Wrap Up
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Select Lighting Fixtures > Ceiling Light - Linear Box

[ R Load Family .

Look In: ( K U(mnqﬁxues

Ju Exterior

. Ceiling Light - Flat Round.rfa

. Ceiling Light - Linear Box.rfa

| Downlight - Recessed Can.rfa

__ Downlight - Spot.rfa

. Downlight - Strip.rfa
Downliaht - Under Cahinet da

Date modified

8/25/2010 3:07 PM
9/3/2010 10:40 PM
9/3/2010 10:40 PM
9/3/2010 10:40 PM
9/3/2010 10:40 PM
9/3/2010 10:40 PM
Q73010 10:40 PAS

vl & B ¥ B gews v

4 pn

-

File folder
RFA File oo

~, A
RFA File @
RFA File >
RFA File

RFA File
REA File

Add the light fixtures to the labs. Align and Rotate into position

Place 2 x 4
Lighting
Fixtures on the
Grid near the
counter edges

n
'
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Counter Tops
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=Duplicate
=Position

"Align & Lengfil Perspective View:

=Layout Ogtions

Cabinet§
=Base& Wall
=BasgiCabinets
“Wall'Cabinets

|§land & Wall Benchés
sElevation
=\/iew Depth

=Center Labs
=Classroomsg

=*Hung Ceilings
=Origin &/Location
sLights &
Supply/Return

=Double'Bay.
=View Range
=L gcation

=Lights

=Typical Plan
=Teaching Labs

Wrap Up
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View showing the addition of the 2" x 4" boxed lights
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Counter Tops
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=Duplicate
=Position
=Align & Length

=Layout Ogtions

Cabinet§
=Base& Wall
=BasgiCabinets
“Wall'Cabinets

|§land & Wall Benchés
sElevation
=\/iew Depth

=Center Labs
=Classroomsg

sHung Ceillngs
=Origin &/Location
sLights &

Supply/SSin Load Family:

=Double'Bay.
=View Range
=L gcation
=Lights

=Typical Plan
=Teaching Labs

Wrap Up

Building Tech IlI
CityTech

Add Mechanical:

Load the Mechanical families and add Supply and Return Registers in each Lab.
| s | s | s s | s | oo | rossne § ¢

] - - ]
o et L[] ] T
Regiaters h..- [ ——— H

Supply
Registers

!

hii

A

SN Iil
mH ]

F

i

| Troffes Light - 22 Parabolic.da 9/3/2010 1040 PM  RFAFile
, Troffer Light - 224 Parabolic.rfa 9/3/2010 1040 PM  RFAFile

| Troffer Light - Lens.fa 9/3/2010 1040 PM  RFAFile ol S X ES vews v
| Uplight - Strip.fa 9/3/201010:40PM  RFAFile " Prevew

| Wall Lamp - Bracket.rfa 9/3/201010:40 PM  RFAFile

m
Fle name:  Troffer Light - 2x4 Parabolc.rfa
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Perspective view showing the Parabolic Troffer Lights & Mechanical Registers
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After we have completed the 6th level we will make copy it to create the
remaining typical floors levels 3 through 6.

® a ® Q Q) o ® ©
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Create a single large open teaching lab in the center lab suite by deleting the

middle walls and casework and adding additional islands.

—————————1— Dealete Walls and
| Casework to craate

open teaching lab |

Array the islands across at a spacing of 10'-3" to complete the lab.
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Remove Doors:

Outside Suites:

Remove the dﬂﬂrs from the center bay.

m'_'_m e

Remowe the doors from the center

l“"ml l
FD)

il

Create a medium size open teaching lab in each of the two outer lab suites by
deleting the middle walls and casework and adding additional islands.

Delete Walls and
Casework To Create

p—t— Medium Sizeé ——t—ij
Teaching Lab
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Array the Islands:

Array the islands across at a spacing of 10'-3" to complete the lab.

Copy'lsland Bench & Casework

i Remove the doors "

from the center bay

|
e
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The lower two floors will be dedicated to teaching labs. We will remove some
of the walls and doors and make 1 large and 2 medium teaching laboratories.

.
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